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Q.5 30 HagER 2024 dP bl RRAfd F IR, FAfAREd 7 I I Jgb AY $ INS Ydeq Aqg
& A& (chair) &2

Ans x 1. 3791 31, HIgMG (Amina ) Mohammed)
x 2. TS BRI (Csaba Kérosi)
« 3. WY 9737 (Anténio Guterres)
x 4. e b (Volker Turk)

0.6 figwdi Ruf<id AR & I Aus AcHl 7 A v fgferf@d 7 3 oI 241?
Ans x 1. GdRMH 99
x 2. 91d g
« 3. 3I1e e
x 4. IGAWR 311G
Q.7 Hfge3l & forv YHIA AL &l 9¢Idl &1 & 3699 A 1873 H V¢ UhIIS (Annette
Ackroyd) gRT da®dr ¥ fAgferfad & 3§ o17-3t dven @il 18 &i?
Ans x 1. 3 AEAT Bictsl (Arya Mahila College)
v 2. féq AfgeT fdenetd (Hindu Mahila Vidyalaya)
x 3. 19 IR BieisT (Queen Mary's College)
x 4. TUASIET Afgell faYfIened (SNDT Women's University)

0.8 fF¥ ITBS PT Jdey UHiddl &I AABR A &2
Ans x 1. 3<68¢ 23

0.9 Hg 2025 H, ufayfa a15R ¥ Higive g 3R gReRfdr 9e1 & fav adig ufayfa 3k
fafmg 91 (Ad) g1 Fafaf@a 7 @ S1-d ggd g& 18?2

Ans x 1. f3fSred 3iifee oot Rven

x 2. ¥ 2371 & oI U YPTdTT §eBH
« 3. Jdf&d ardl a9eT (RPT) & forw Imffa qida
x 4. FA39% IJR&0T 3R A FarRe fidd
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0.10 fAgferfad & A feua eelk1 & 9Rd &I ggel 3refard® A1 (semiconductor
fabrication) s®Ts TfUd &1?

Ans x 1378 9

« 2. 22T ol e
x 3. fao
x 4. R g2 1=t

0.11 3i. MIMR19 S ®HR I URd Id A od JHfAd fHaAT =7 o012
Ans x1.1952
x 2.1960
¢ 3.1990
x 4.1980
Q.12 B3 HINUI: ATIHTd Y fapT1d AR & &> folv ggusrare &l Hsiqd &1, Faferfad
¥ & fru siafgha agg 3 Jefed 82
Ans x1.G20
x 2. 9TET8 AT I3 (Shanghai Cooperation Organisation)
« 3. [T (BRICS)

x 4. H@Wq\é uforS QT@' &T I3 (Association of Southeast Asian Nations)

0.13 fgferf&d & & &I9-11 A, didl 3dTG® ATel 82
Ans 1. 0579

x 2. ASRAT

X 3. 3RAEs

x 4. 7e UG 9A

Q.14 2011 &I SPIVHET & TR, Sl DI ATSRT &3 1971 fbd-it oi?
Ans 1.94%

x 2.85%

X 3.90%

x 4.99%
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0.20 HUSHT yunell #, AHAR 4R PR ST IfAAT (head) fHA w&l STl &2
Ans x 1.39cufd

x 2. 14T

3. JerHAt

x 4. g

Section : Logical Reasoning

0.21 &1 718 g&ell # Y-F=g (?) & AT IR T 371 A1g0?

34, 41, 55,76,104, ?
Ans x1.138

x 2.137
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0.23 AT 3419826 & AP 3id &I 10 A GIV 3Rl HH T AdRRAd B34 R &1 48 g §
910 F gAY AR 10 A AW 30T BT UG fHd-T gm?

Ans 1. >

X2 18

x3. 16

x4 14

0.24 ABTUTA Q @IA BT YT W &1 L I 7TdT W &1 L &Y Uell C &1 L &1 A I 1 Ade 82
Ans x 1.3 &I G5

x 2. 975

o 3. A BT g

x 4.9
0.25 T <’ 3R~ B R el f&AT S0 a2 “+ 3R+ Bl RAR 9l f&ar e, d
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Q.26 fHferfd J@a-goal 7, ygell J&A 4R A IO AfpAT S3b Ul JwA urd 61
STt 81 X 3R Y & 217 4R $I-HT A0 30+ arfge, arfe - & a1 3R 61 S G030
GRT ARV 61 -1 G, : & Q1 AR B q JWAT3T gIRT AR P00 de & qur
& Sme?

(Are: J@A3M B 3P geP 3idl A dis a1, Quf Y3l gv ARBATY $I s-it =nfgel
3TERY & felv 13 fif3rv - 13 4R JfpATY, A 6 SMA1/9eT1/70n HIA1, dd 13 R
ST AEdl €113 &1 1 31R 3 T diga a1 6 1 3R 3 R IOy AReAT0 37 ) 3afa 48
el)

X:69::43:Y
Ans 1. X=35,Y=85

x2.X=32,Y=88
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x 3.66

x 4. 65
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Q.29 2 s FIfYd db & AR 8 A AdAd &1 3 db & AR 7,343 A AT 213N db &
AR, 9 FEfaf&d &3 13 fabedi 7 9 fHud Jdferd 82

(Are: TBA3 Bl 39F g il § dis foqr, UleATT guf J=A3M gv 61 S+t arfgel
3GTERY & felv 13 &) eifore- 13 4R AfFATC 3 6 13 & SANSH1/geT1/3[00 BT MY
foBdT ST AHdT &1 13 &I 1 31 3 § drs1 3R 63 1 3R 3 R IO JfpaTe 37 6

srgafa =1 1)

Ans x1.720
& 2.729
x3.732

x 4.716
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Ans 1. 14

x2.13

x 3.12
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Ans x 1. Egypt: Africa
« 2. Nepal : Australia
x 3.India : Asia

% 4. Romania : Europe
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0.32 A1 80364561  YA® 3id P 910 A IV d¢d oH § AaRAd fHAT 37141 81 gl J@AT I
qor1 | feaq 3iel &1 fRxAfa sraRafda @f?

Ans x 1.Udh
v 2.3l
x 3. dR

x 4.9

Q.33 3i3SH quinTer 4 & MR R, FEfAfEd IR AeR-Tg A 7 A i v [AfFd adie 3
USIAT ¢ 3R 3 YBR d UP JYU §-1d &l DI-IT JeR-TYg 0 39 4 I Adfd 98 &2
(A1C: 3R HER-TYE P, AsTHI/I[RT b1 YA AT 391 AT 4= 3rerRd =l 21)

Ans x 1.JM-0G
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0.34 Fufaf@d S g@cn 1 dqof difoe 3R 39S q1g QU 30 9y &7 3R e
(dIU) 412645719210192801712903520 94 (3I0)

¥ fpaq faun 31 €, BP e ugat v guf 3f 2 3R &ies a1 & vap 9w 316 82 (1 oft
gof 3of @)

Ans x1.d9
x 2.9
x 3. ar

v 4. TR



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

0.35 Fferf@d 318R @t &1 dad o 3R i3 fqe 710 9y &1 30R &1 Bradt aa 910 A Qe 61
sty =nfeel
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IWRI® g@en ¥ VA fpaa AeR &, 50  yAF & &P ugd veb WR 3R 8 915 v
A &2
Ans x1.dI9
x2.Ub
WERIE R EIEE
x 4.3

Q.36 3 1 &1 I BI 3Nl 13 XU 370 Iaf & ur de &1 3R Har &1 Q1 o I
de &1 IR0 B4 8l
LOQ : NQR
CFI : EH)

Ans 1.FLR:HNS
x 2. EMR: FOS
x 3.GLP : INO

x4.DEN: FDO

0.37 'OCEAN' 9% & Ucd® 318R &l 31U quitrelr &0 4 39d dd d1g 3114 drd 318R I 9qd
fem ST & 3R fBR 39 YR yra 9oft 318RT & aviaren o0 § afq f&ar simdar 8139
YPR 94 dlet 318RT & A0 g § Fyfaf@d ¥ & S19-91 3R d10 F dR A1 9= go1?

Ans x1. M
v2.F
x3.E
x 4.0
0.38 & 7T$ 38R Y@cll &1 A 3 3R 3TP d1g U 1T 9Y &1 IR ifsel Pradt daa a1
& qre 61 St =gl
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Q.39 3W 4 &1 I HIf¢ 31t 9 4e 10 Poui & Jar de &1 IR0 SId1 81 Qi A
I G BT 3R FI4 &l

MCW : EUO
AKU : SCM

Ans 1. cMT: UEL
X 2. WXY: XWZ
X 3. RAT: JSB

X 4. GHI: YAR

0.40 Bg Sl A, B, C, D, E 3R F Uds & HU3 U IW U g, cifepT ST&3T 781 fop I o3t 0 o 3@
MU E A B HUR A T AT R 3G 51-1 81 D 3R F F i de 31 diqy 3@ 910 §1 E D
C & 1P HUI IW AT &1 D BT A & S1d 12 3771 77T 81 B BT A &SI HUR AT IAT &
D 3R ¢ & o9 fpa dia A v &2

Ans 1. U®
xz.a‘r
x 3. IR

x 4. GG

Section : General English and Comprehension

Q.41 Select the option that has nearly the same meaning as the underlined group of

words.

Marissa Mayer, the former Google and Yahoo executive, believes that Artificial

Intelligence should simplify our lives but gives notice beforehand especially of
danger or evil the real battle for the future will be determined by how the US and

China embrace this technology.
Ans x 1. detects
x 2. advises
x 3. discusses

« 4. warns
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Q.42 Select the most appropriate ANTONYM of the given word.

Slender
Ans x 1. Narrow
x 2. Elegant
« 3. Chubby

x 4. Fragile

Q.43 Select the most appropriate option to fill in the blank.

He arrived __ because he did not want to be late.
Ans x 1.slowly
x 2. nearby
x 3. always

& 4. early

Q.44 Select the most appropriate option to fill in the blank.
The cat chased the around the garden.

Ans x 1. mosquitoes
& 2. Mice
x 3. beatles

x 4. ants

Q.45 Select the most appropriate meaning of the given idiom.

'Sat on the fence'
Ans x 1. Took an active role in a decision.
X 2. Supported both sides equally.
x 3. Remained confident throughout the discussion.

« 4. Avoided making a decision or commitment.



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Comprehension:

Read the given passage and answer the questions that follow.
The Famous Five - Julian, Dick, Anne, George and Timmy the dog - arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. | want to bathe six times a day!"

Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs - a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,

but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure - we always do.

SubQuestion No : 46
Q.46 What flowers did the children see on the way to Kirrin Cottage?
Ans x 1. White poppies

% 2. Blue cornflowers

x 3. Bluebells

« 4. Red poppies
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Comprehension:

Read the given passage and answer the questions that follow.
The Famous Five - Julian, Dick, Anne, George and Timmy the dog - arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. | want to bathe six times a day!"

Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs - a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,

but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure - we always do.

SubQuestion No : 47

Q.47 What is the OPPOSITE of the given word?

Perilous
Ans x 1. Dangerous
x 2. Evil
« 3. Safe

x 4. Risky
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Comprehension:

Read the given passage and answer the questions that follow.
The Famous Five - Julian, Dick, Anne, George and Timmy the dog - arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. | want to bathe six times a day!"

Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs - a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,

but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure - we always do.

SubQuestion No : 48
Q.48 What is suggested by Timmy's growling?
Ans x 1. He s thirsty and hungry.
% 2. He wants to run along the sea.
x 3. He dislikes scones and does not want to have them.

« 4. He senses impending danger.
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Comprehension:

Read the given passage and answer the questions that follow.
The Famous Five - Julian, Dick, Anne, George and Timmy the dog - arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. | want to bathe six times a day!"

Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs - a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,

but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure - we always do.

SubQuestion No : 49

Q.49 What is the meaning of the given word?

Quest

Ans 1. Search
x 2. Surrender
x 3. Neglect

x 4. Queer
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Comprehension:

Read the given passage and answer the questions that follow.
The Famous Five - Julian, Dick, Anne, George and Timmy the dog - arrive at Kirrin Cottage.

"There won't be time for any adventure these hols," said Dick, regretfully as they walked
down the lane to Kirrin Cottage. Red poppies danced along the way, and in the distance, the
sea shone as blue as cornflowers. "Only two weeks and we go back to school! Well, let's
hope the weather keeps fine. | want to bathe six times a day!"
Soon they were all sitting around the tea-table at Kirrin Cottage, and their Aunt Fanny was
handing round plates of her nicest scones and tea-cakes The children chattered eagerly,
unaware that a shadowy figure watched them from the cliffs - a figure who would soon
draw them into a perilous quest for hidden treasure. Timmy growled softly sensing danger,
but George ruffled his fur, "Don't worry, Timmy. We'll find the adventure - we always do.
SubQuestion No : 50

Q.50 What is the main idea highlighted in the passage?

Ans x 1. The importance of keeping pets

« 2. Childhood curiosity and adventure

x 3. Family picnics

% 4. The perils of the sea and cliffs

Q.51 ‘Gidl ddl 33Tell GEET JgIa¥ &1 T 319 &2

Ans 1. 3YITfBd gl
x 2. f&q @1 9 ®en
x 3. SMABR I ard YT
X 4. 3191 39Teh BreT
Q.52 f&U v a1 # Reb AT & foIv 3ugth BRP |
g A .......... FTH B A1 M|
Ans x1.&
x 2.7l

o 3. Pl
;(4.@



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

0.53 3R’ &1 gAfaardt oI &2
Ans x1.349

v 2. 3R

x 3. 934

x 4.30d

0.54 fAgfaflad faecul ¥ A it & Adl 37 &1 TIT B
‘Hdl gBTH BIPT UPpart &I 7 &

Ans x1.9g! gl

v 2. Pdd d1gl 9gLH

x 3. Wrexfgd WS

x 4. el g1
0.55 ¢ 7T RFedt ¥ F3qzedt #1 whw few weg gav-
Ans 1. e

x 2304

X 3. 3T6cTH

x 4.3197
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Comprehension:

el & 3MeR R FAgfefEd g4l & 3R dfSiv-

‘HETPIA DI Uaiel BT off Bad & YT Afecd N 9P folv ‘Uies’ oreg o1 YT ol STl & |1 I8
37id YTl Brod faer &1 AR J&l AU 3R HgT9Rd 5 faenet Heldied ford v §, f5ig 3ushsd
Bqg off el STl ¢, RNb I TRad BIdl 3R HerdpIdl & Ard ot €1 sufere uri- Iy 3 &9 faer
&b By U 180N IR 1R {31 STIdT 6T &1 HeTbIed ‘Hed 3R ‘P18’ g <l A< | i g g
‘BT P A1 Hed UK BT TIPT JI Ugal AT dp-AAIr § fAedl 8- Bl HIT Agd: ad qrat
gfAgera: |7 59 Ufth I HEldId & il oIeull 4R b1l USdl ¢- HelbIod & HATPR Pl faemetdr, feadt
HgT IR &1 Y8l 3R TOrdT &1 HeTdT | 9RO SIS & Juad : Ay 3 arag 3
HgIPIed & awy — R0 1 g9 o138 Wawy faem & 3R 4R H1g & qid 9g U 8|

SubQuestion No : 56

Q.56 e & feIv 3ugh Méd &1 949 Hifsrv|
Ans x 1. GBI

x 2. IRd 1

X 3. b B

v 4. FEIPT
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Comprehension:

el & 3MeR R FAgfefEd g4l & 3R dfSiv-

‘HETPIA DI Uaiel BT off Bad & YT Afecd N 9P folv ‘Uies’ oreg o1 YT ol STl & |1 I8
37l Urei- Broy faer &1 AR J&l AU 3R HeT9Rd S faene Hereied ford v §, f5ig 3ushsd
Hqg off el STl ¢, RNfb I IRad Bl 3R HerdpIadl & Ard off &1 safere uri- Iy 3 &9 faer
&b By U 180N IR 1R {31 STIdT 6T &1 HeTbIed ‘Hed 3R ‘P18’ g <l A< | i g g
‘BT’ P A1 Hed UK BT TIPT IId Ugal AT dp- AAIT § fAeTdl 8- Bl HIT Hgd: ad qrat
gfAgera: |7 59 Ufth I HEldId & il oIeull 4R b1l USdl ¢- HelbIod & HATPR Pl faemetdr, feadt
HeT IR &1 YfasT 3R TOrdT &I HeTdT | 9RO SIS & Juad : Ay 3mar arig 5
HgIPIed & awy — R0 1 g9 o138 Wawy faem & 3R 4R H1g & qid 9g U 8|

SubQuestion No : 57
Q.57 e ¥ Ugwh U= &1 faalid or=g am-
Ans x 1.37fcH
@ 2. 31arEA
> 3.0

x 4. 959
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Comprehension:

el & 3MeR R FAgfefEd g4l & 3R dfSiv-

‘HETPIA DI Uaiel BT off Bad & YT Afecd N 9P folv ‘Uies’ oreg o1 YT ol STl & |1 I8
37l Urei- Broy faer &1 AR J&l AU 3R HeT9Rd S faene Hereied ford v §, f5ig 3ushsd
Bqg off el STl ¢, RNb I TRad BIdl 3R HerdpIdl & Ard ot €1 sufere uri- Iy 3 &9 faer
&b By U 180N IR 1R {31 STIdT 6T &1 HeTbIed ‘Hed 3R ‘P18’ g <l A< | i g g
‘BT P A1 Hed UK BT TIPT JI Ugal AT dp-AAIr § fAedl 8- Bl HIT Agd: ad qrat
gfAgera: |7 59 Ufth I HEldId & il oIeull 4R b1l USdl ¢- HelbIod & HATPR Pl faemetdr, feadt
HgT IR &1 Y8l 3R TOrdT &1 HeTdT | 9RO SIS & Juad : Ay 3 arag 3
HgIPIed & awy — R0 1 g9 o138 Wawy faem & 3R 4R H1g & qid 9g U 8|

SubQuestion No : 58
0.58 UTYT AR & HgIdhTA & forv b A &1 YA B imar & 2
Ans x 1. PIR |
x 2. PIAS!
¢ 3. Ufu®

x 4. fov=q
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Comprehension:

el & 3MeR R FAgfefEd g4l & 3R dfSiv-

‘HETPIA’ DI Uaiel BT off Bad 8| YT Afecd ¥ 9P folv ‘Uies’ oreg &1 YT fapdT STl & 1 I8
37l Urei- Broy faer &1 AR J&l AU 3R HeT9Rd S faene Hereied ford v §, f5ig 3ushsd
Bqg off el STl ¢, RNb I TRad BIdl 3R HerdpIdl & Ard ot €1 sufere uri- Iy 3 &9 faer
&b By U 180N IR 1R a1 STIdT 6T &1 HeTbIed ‘Hed 3R ‘B’ g <l A< | i g g
‘BT’ P A1 Hed UK BT TIPT IId Ugal AT dp- AAIT § fAeTdl 8- Bl HIT Hgd: ad qrat
gfAgera: |7 59 Ufth I HEldId & il oIeull 4R b1l USdl ¢- HelbIod & HATPR Pl faemetdr, feadt
HgT IR &1 YAsT 3R TordT &1 HeTdT | 9R AT SIS & Juad : Ay 3mar 9rag 5
HgIPIed & awy R0 ST g1 o 13817 Wawy f3em & 3R 4R H1g & qid UG U gl

SubQuestion No : 59
Q.59 EHIR Il I A &I 93 HelbIod ford v ?
Ans  x 1. JRAPR 3R ARG
x 2. AR 31 ST
x 3. ITIRTATTT 31 a7 afyem

4. TATI0T 3R HEIRd
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Comprehension:

STENl & MR IR fAgfeifad Ui & 3R difse-

‘HETPIA’ DI Uaiel BT off Bad 8| YT Afecd ¥ 9P folv ‘Uies’ oreg &1 YT fapdT STl & 1 I8
37l Urei- Broy faer &1 AR J&l AU 3R HeT9Rd S faene Hereied ford v §, f5ig 3ushsd
Hiad off e STl 8, TP T Wadi Bl 3R TeTdrA & Ard off g1 sAferw wdi= I I 59 faen
b IIBY U9 AN IR IR fBa1 Sidl YT &1 Heldhlsd ‘e 3R ‘Pl g dl Ueal I I UG ¢
‘BIS F A1Y HE A% BT T T Ugel AT op- MO & fAeTdT 8-“dhdl BIrod Hgd: ad ardr
gfAgera: |7 59 dfth I HeldIad & i oIelull 4R YahIl USdl ¢- HelbIod &b HATPR Pl faemetdr, feadt
HgT IR &1 YAsT 3R TordT &1 HeTdT | 9R AT SIS & Juad : Ay 3mar 9rag 5
HgIPIed & awy R0 ST g1 o 13817 Wawy f3em & 3R 4R H1g & qid UG U gl

SubQuestion No : 60
Q.60 eI YIth 3N A< BT 37 R ?
Ans x 1. TSN 9 ordT &

x 2. SR NgTTEaaa

x 3. Tt Smas wgeft et @

4. 5% I8R Siad Ierdr &

Q.61 W B (array formula) & &9 ¥ &af f6A Bifd &1 3UAT THTH URIel 2019 H 1
SHa¥ 2024 I I® @17 drel 3R 10 URBAT (rows) & ferv 7 &A1 B Ifg & Ay ArfrEl &1
3IPH SR B & foru BT ST =Ifge?

Ans x 1.=DATE(2024,1,1)+7ROW(AT:A10)
x 2. =DATE(2024,1,1)+7SEQUENCE(10)
x 3. =SEQUENCE(1,10,DATE(2024,1,1),5)
o 4. =DATE(2024,1,1)+7*ROW(1:10)
0.62 WI¢HIA aIs-BIs ¢fhd (Wi-Fi traffic) &I Uf~pe &34 & ferv fAferfad & d s-T1
Nreic WA JRIAT AT SATdT 872
Ans x1.HTTP
x 2. WEP
x 3. WPA

v 4. WPA3
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0.63 fferfad ¥ A H1-At BIaR $I 319 &GS e’ AR & Arean A Uil R IPHd 8?2
Ans 1. 33 AT BT vgsRe BT

x 2. CPU 3TR B} 3917 &l fPRI= @91

x 3. I 57 U T &Y g

x 4. FAIfBATMA (non-responsive) AT B FHHICT BT

0.64 30 HRABAT (email communication) & felv #1-s 3R Ndiad AeiRd s F fore
BIT-9T FT3T Idaert 8?2

Ans x 1. BEvcl HRIFABLIH BHIMH (Federal Communications Commission - FCC)

X 2. 3T APTAISIIL BIR W SS831H (International Organisation for Standardisation
- 1SO)
x 3.dcs d188 a9 Hulfedy (World Wide Web Consortium - W3C)

@ 4. 5T SINTAFNIT 213 BIY (Internet Engineering Task Force - IETF)

Q.65 $Ad & b AT § UIddbdi &1 S8l U aidl &?
Ans x 1.Signature

¥ 2. Subject

« 3. 10

x 4. Body

Q.66 UTW Ad $ai WIR ard &2
Ans x 1. Outbox

« 2. Inbox

x 3. Downloads

x 4. Files

0.67 UG ATFAAR BT 3Y-g-3¢ I@T Rt Aecaqof &2

Ans 1. FATdH IRRY IRUTHTY AR e 9 (security patche) U B & v
X 2. PRI P WWHIRHY B JH(PHTSST (optimise) B3 & faiv
X 3. AdIaH RIS RS HUST & WY FAdT (compatibility) JFATYT B & ferw
x 4. AT dIR & Afhdbel 2% (graphical interface) &1 g1 & folv
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0.68 fAHferf&d ¥ ¥ B11-AT HLIeId 8?2

Ans x 1. 3518 Creiey ¥ qdfAeiRd g8y drell Ueb wirss gidl 2|
x 2. 39 & foIU Y32 HICH Pl UHUY UTaRuise & A1 309 fBar 517 I gl
x 3. UHUY UTaRUTEe SHcie, ¥ales bl Te a1 wiflie ardr &l

o 4. 3318 STy 39AMT & flU dAIR (ready-to-use) i & S8 39 379 SAGINT “Ra
gl

0.69 8H PDF WIgd # fiie gy (Print Preview) ¥ 3@ Adbd &2
Ans x 1.Use print production > Input preview Jcidpe B3

x 2. Use file production > Output preview Il &

¢ 3. Use print production > Output preview Jcie ®¥

x 4. Use print preview > Output preview Hicbc B

Q.70 HISHINIIU ds H, 'Track Changes' &1 HT S &?
Ans x 1. RE B BIHC BIAT

x 2. IeuRfeid g9¢ AT

3. STagHE H fBU 10 IAUTEAl BT ¢ BRI

x 4. 29 3% e g4l

0.71 fufaf&d & § &17-91, $RYLR IR F TSR 1 U 3aIeIUAE! a7
Ans x 1.215 & (Trojan horse)

« 2. @7 (Plugin)

x 3. g (Worm)

X 4. TT3A (Spyware)

0.72 MS g3 sipgHe | fg3d SRe B A 3ii/3i% fHan Jrar g2

Ans 1. File -> Options -> Display -> Hidden Text UR 3TU-> Tick IT Untick &3
x 2. File -> Options -> General -> Hidden Text UR STU-> Tick AT Untick &3
x 3. File -> Options -> Proofing -> Hidden Text 93 3lTU-> Tick AT Untick &3

x 4. File -> Options -> Language -> Hidden Text U% STU-> Tick AT Untick &3
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0.73 SNAd (Gmail) # B §-Aet USA T BIgdd AT B BT YT BId THY Jfe Ha (error
message) ‘The file size exceeds the maximum allowed size’ &T TG HHTFId BRI
frgferfEa & 3 - €2

Ans 1. 379 fSRT BISE P 30T P BT YIR PR 38 & 96 9gd 99! 8

x 2. 5-Hal IR ¥ 31fdddn Brsd Ass fafie g
X 3. 37T 3 BIgd BT 318 B BT JATY B 33 &, I8 Ub HIE BIsd gl
x 4. 379 f5I BISd &I 31¢T B3I BT YT R I8 6, 96 UP IRy g

Q.74 UHTH URIE 2010 H, T &34 g UHIfAd dbefic &I 994 &1 & e, ugell abefic ©v
faele &7, 3194 HIds W Pl qaTU ¥ 3R Y &I off 39 AfaR® abadfic ®

fde® &% O 37 ATfAe ST 918d &l
Ans x 1. Esc
x 2.Tab
« 3. Ctrl

x 4. Alt

0.75 fHfafad ¥ I 5 due RFRA & fav arefe AT 7rr Ardan 82
Ans x 1. FIfAd ditedR 3193e
x 2. i1 qrads e
X 3. PHAIRAT P AU faqga gRam gfrerm
v 4. 3OS AT dIR YU
0.76 fuferfEd & & SI-T1 YRan dF I 94 3R AT $7 & fore I & fF et A
(message) ®I Ad H3a NI 3UH PIg yRad =i fopar sram &2
Ans x 1. UfXPWH (Encryption)
gZ.%T@TW (Hashing)

X 3. T3 UTI8de Acadb (Virtual Private Network - VPN)
x 4. f8fSieet RU=R (Digital signature)

Q.77 UAARIRA iFedAR $l AR AR (generations) &I HH
8l
Ans  x 1. SIS T, GIRRCS IR, Upfefdadt U 31X qui-faQIvdrsi arell gram
x 2. [uct IBR, vpfefadt ¢u, #Ad I5ige 3R qui-faQaarst arel gra
v 3. RT3, GRS IBR, Al ¢ 3R qui-faQIvdrsi arell gram
x 4. RiUe IR, TRRT did, gIRRCP IR 3R QUi-[AQqwdrsii arett gran
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Q.78 fABIA 93 MARIT Uclib -l 7 FoR, #e¥ BITR (Help feature) &I Hal THAT BT
bl &?

Ans x 1. View |
¢ 2. Help &8
x 3. Edit ¥

x 4. File ¢§

Q.79 3119 UHUY YTdRYIEe W58 & 3iG3 ¢ Pl $d Uf3e B IPhd &7
Ans x 1. %28 HINCR Wil 3R Edit Text Aot B

¢ 2. PR @A 3R TRE 218U B IT ST B P ol¥ TRE i & 376 fadd B3
x 3. W88 R A8 -fid B3 3R Add Layout Faide B
x 4. 9894 (background) S&ald & oI Bific ¢d BT 3TN B3

0.80 UHUY Uald ¥ &I YoR Bl At A o[ (fraction) A TR B APdl 87
Ans x 1. 37T (AutoSum) IR &1 39T B
x 2.89¢ (Insert) > R (Symbol) BITR BT 34T HIb
v 3. IR & d1¢ WA 3R B BAFAR 2189 BRb
x 4. BiHe I (Format Cells) ST i I 39T I
Q.81 40 YADI &I f4hd Yo, 46 T¥API S HI oI S SRR &1 I AT o1y gfererd s
$ifsre)

Ans x 1.159, 81

x2.100 oy
6

o 3159, Al

x 4. 12°%€rﬁ

Q.82 R1a1 3R ABIAT U &4 Bl BHE Uid & 3R N &7 7 qR1 &% 9bd &1 afa 3 Wy
TR BT SBIAT Y& BY, dl B GRT B3I ° I dIddl 9 Siid HIfSv|

Ans 1. 4faq

x2.5f

x 3.10 f&gq
x 4.2 feq
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Q.83 U YePIISl 51 40 km/hr & 30d dTel & deldl &, dl 3197 Sided 4R g5 & ugddi 81 51
gH 3T dlcT 30 km/hr & STl &, A I 39 3ider 4R 10 e 8 F ugddt &1 arn
61 ¢dl grd $ifsrel

Ans x1.80 km
v 2. 20 km
x 3.40 km

x 4.60 km

0.84 6.5, 10.6, 20.3 3R a &1 31d 12 &1 a &I HI 3ITd HIfATI
Ans x1.96

v 2.10.6

x3.116

x4.12.6

Q.85 26 x 4 x 720 + V2304 = y + 514°P1 UQE P ATl y BT A Fra I
Ans x 1.1047
v 2.1046
x 3.1037
X 4.1052
Q.86 dferebl b1 adHI-T 311 BT 4 AT, AATPS I adHr 31F & 2 I A 18 9¥ AP &, A1 AATS

b1 IdHI 31y BT 8 I[1, cfeiepl H1 adHIa 31g b 8 I A 8 a¥ HH g1 el 3R AAD
61 qdHT 3mg &1 F17 (99T 7) 1d Hifsre|

Ans x1.14
& 2. 15
x3.20

x4.19

0.87 ATE x BT 4% = 168 &, dl x A ¥ I fpad TR 8?2
Ans x1.8400

x 2.8500

v 3.4200

x 4.4300
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0.88 1850 - [450 - {210 - (90 - 80 - 7)}] &I I siTd HIf3C|
Ans x1.1537

x 2.1467

x 3.1682

v 4.1607

0.89 210 m ddl U Yepal, f[audd faem & 4.5 km/h 6 AT A Il Ig U AT Pl 12 Adbs §
qR &l &1 YerPnel & a1 (km/h ®) sird Hifsre]

Ans x 1.60.5
x 2.59.5
¢ 3.58.5
X 4.61.5
0.90 U% BR $I HI°d ¥ ggal 20% b1 Ifg I 3l &, B 30% $i gfg & arelt &, 31 =
50% &1 Sl HI STl &1 FR HI Hia & Ae ufvad fea-n gem?
Ans 4 1.22% &1 HH
x 2.25% Pl Ifg
x 3. ®Is gRAd T8
x 4.20% bl HH

0.91 4-4 a¥ & iAW WX TR, Ui I T 31 BT AT 60 ¥ 81 S1F HeF arat 9 BV 31 |1
&?

Ans »1.12
x2.16
x3.20

x 4.24

0.92 IR 3MiERI X, Y, Z 3R M & &9 U fqen=1un 919 #, Z 31 25,000 dic fAa s1€f® ¥
B 28 20% 3P A firel| A9 AT T I, fasidr M 1 60% dIc e 3R 3ITAX R
50,000 dIcl & sfid e1Riet $11 Aoft 91T ®) de w1d gO, Y1d H STed 7€ dIdT &6 JHwA
fooar o2

Ans x1.2,50,000
x 2.2,90,500
x 3.2,06,080

« 4.3,05,000
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0.93 AR 31 _ -1 = g4 & A ZX=L &1 71 g1d A0
2x+3

13
14

Ans x 1.

13
18

x 2.

13
17

v 3

13
12

x 4.

0.94 3 cm, 4 cm 3R 6 cm AT dlal I UTSY U ATY U cobl Bl IR g &l A9W Blel sy
b gREIferd @17 U ¢l &Y 5 H§¢ 3R 7 e ¥ R FddT &1 Y@ 9ISy ¥ Sidd &l YaTg,

3P AT & g & JATGUT giar &1 Jofl g1sul Bl U 1Y bl Bl 9RA § o fbd-T
Iy (ST /) Pbm?

Ans x1.24
v 2.27
x3.25
x4.26

0.95 fAgferfad ¥ A $19-d 17 g« 91 82
4 6 40 15

6’ 38’ 57’ 49
Ans 1. 6
38
15
49

0.96 UTd J&AT3W BT APTHA 655 &1 gell & JSAT3N &1 31Td 76 & 3R A Jw=a 114 &1 A9
&l Y13t &T 3d sird HIf3rv|

Ans x 1.191
x 2.195.5
x 3.190

v 4.194.5
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0.97 U Hefi UX 3P fAhd oI U 12% GST P11 JATdl & a2l 3P 3ifed Jed 4R 20% b1
@ge d Sirdt 81 afE GST & ferv 480 &1 yrar 631 irdr &, di 9l &1 3ifed e dd
RIS

Ans »1.35000
x 2.34,800
x 3.34,000

x 4.34,500

0.98 U® gHIaR 31 H 10 WP & IwT S9dT &, S 30 40% &1 @ gl g1 39131 |
fpdl wnfes  Img TS &2

Ans x1.13

v2.14

x3.1
x 4.12
0.99 Us Afth BI AT 3AP! 99d A 40% AP 21 I 3AP! A 31,20,000 &, Al 3BT AT
(% #) g1d $ifrel
Ans 1.70,000
x 2.52,000
X 3.54,000
x 4.68,000
0.100 f&I 9¥g HT 3ifPd Yo 3P BT Yo A 186% AP 21 G a¥g IR PV B a1 & aig ol
GPITGR 43% P o1 Affd HIdT &, Al gHIIGR gIRI &l 15 {e qfea2rd sird S|

Ans x1.48%

x 2.52%
x 3.49%

@ 4.50%
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